The National Institute of Standards and Technology (NIST) uses its best efforts to deliver a high quality copy of the Database and to verify that the data contained therein have been selected on the basis of sound scientific judgment. However, NIST makes no warranties to that effect, and NIST shall not be liable for any damage that may result from errors or omissions in the Database.

© 1987, 1996, 2008 copyright by the U.S. Secretary of Commerce on behalf of the United States of America. All rights reserved. No part of this Database may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of the distributor.

Certain trade names and other commercial designations are used in this work for the purpose of clarity. In no case does such identification imply endorsement by the National Institute of Standards and Technology nor does it imply that the products or services so identified are necessarily the best available for the purpose.

Microsoft is a registered trademark of Microsoft Corporation; Windows and Windows NT are either trademarks or registered trademarks of Microsoft Corporation.
ACKNOWLEDGMENTS

The stay of S.A. Klein at NIST was funded, in part, by the University of Wisconsin and by a grant from the National Science Foundation under agreement No. 9527385. Any opinions, findings, and conclusions or recommendations expressed in this publication are those of the authors and do not necessarily reflect the views of the National Science Foundation. The authors would like to thank G.R. Dalton and C.W. Levey for editorial assistance, and C.J. Wardell, M.A. Killeen, M.O. McLinden, G.R. Dalton, C.W. Levey, and our industrial beta testers for their assistance in testing the database.
## CONTENTS

1. INTRODUCTION ............................................................... 1
2. SYSTEM REQUIREMENTS ................................................. 2
3. INSTALLATION ............................................................... 2
4. OVERVIEW ....................................................................... 3
5. OPTIONS AND PREFERENCES ........................................... 5
   5.1 Specifying Units of Measure ............................................. 5
   5.2 Choosing Properties to Display ....................................... 6
   5.3 Miscellaneous Options .................................................. 7
   5.4 Saving and Retrieving Options ....................................... 8
6. GENERATING TABLES OF DATA ......................................... 9
   6.1 Saturation Tables .......................................................... 9
   6.2 Iso-Property Tables ..................................................... 12
   6.3 Specified State Points ................................................... 15
   6.4 Manipulating Data Tables ............................................. 19
   6.5 Warnings and Errors in Calculating Tables ..................... 20
7. PLOTS .............................................................................. 22
   7.1 Plotting Data from Tables .............................................. 22
   7.2 Predefined Plots .......................................................... 25
8. ON-LINE HELP ............................................................... 26
9. SAVING YOUR WORK ...................................................... 27
10. EXCHANGING DATA WITH OTHER APPLICATIONS .......... 28

Appendix A. SAMPLE SESSION ............................................. 29
Appendix B. INFORMATION ON PROPERTY COMPUTATIONS ........ 33
Appendix C. INFORMATION ON WARNING AND ERROR LIMITS .......... 46
Appendix D. INCORPORATING STEAM ROUTINES INTO OTHER PROGRAMS .... 49
Appendix E. CONTACTS ....................................................... 60
1. INTRODUCTION

The thermophysical properties of water are of interest in many industrial and research applications. Official international formulations for water properties are developed and maintained by the International Association for the Properties of Water and Steam (IAPWS). The U.S. national committee for IAPWS is the Properties Subcommittee of the Research and Technology Committee on Water and Steam in Thermal Systems of the American Society of Mechanical Engineers (ASME). In 1995, IAPWS adopted a new formulation for general and scientific use for the thermodynamic properties of water, U.S. rights to which were assigned to the U.S. national committee. NIST has taken the responsibility of putting this formulation, along with those for other water properties, into a software implementation. The resulting NIST/ASME STEAM Properties Database, NIST Standard Reference Database 10, provides water properties in a user-friendly manner over a wide range of conditions. The formulations used to compute all the properties are those adopted by IAPWS (see Appendix B). More information on these formulations may be found at www.iapws.org.

The formulation for thermodynamic properties implemented here should not be confused with the separate "Industrial Formulation" (known as IAPWS-IF97) adopted by IAPWS in 1997. IAPWS-IF97 is designed specifically for use in the steam power industry; it is slightly less accurate than the formulation used here, but is computationally faster. In the U.S., software implementing IAPWS-IF97 is distributed by the ASME; further information may be obtained by contacting them at infocentral@asme.org.
2. SYSTEM REQUIREMENTS

The STEAM database is designed to run on any personal computer capable of running Microsoft® Windows™ 98, 2000, NT, Me or XP™. A hard disk with 20 megabytes of available space is also required.

The database is available in the following disk format:

CD-ROM

3. INSTALLATION

Place the CD-ROM in the CD drive. In Windows 98, 2000, NT, Me or XP

Start the installation by either double-clicking on the install file SETUP.EXE on the CD via the Windows Explorer or My Computer, or by clicking on the Start button, selecting Run and entering the appropriate location for the installation file e.g. D:\SETUP.EXE (if the CD-ROM drive is assigned the letter D:).

Follow the remainder of the Installation instructions.

If you have purchased a version with source code, it will also be installed by default if you downloaded the installation from the web. Otherwise the code will not be installed, but can be copied of the accompanying floppy.

To start the program, go to the start button, Programs, NIST, and click on steam.
4. OVERVIEW

When the database is started, an informational window appears as shown in Figure 1.

![NIST/ASME Steam Formulation for General and Scientific Use](image)

NIST Standard Reference Database 10, Version 2.21
A.H. Harvey, A.F. Peskin, S.A. Klein
Copyright 1996 by the U.S. Secretary of Commerce on behalf of the United States of America

NIST uses its best efforts to deliver a high quality copy of the Database and to verify that the data contained therein have been selected on the basis of sound scientific judgement. However, neither NIST nor ASME makes any warranties to that effect, and neither NIST nor ASME shall be liable for any damage that may result from errors or omissions in the database.

![Continue Information](image)

Figure 1. Introductory informational dialog box.

NOTE: The figures in this manual show windows and dialog boxes as they appear in the Windows 95 operating environment. If you are in another environment (such as Windows 98), their appearance may be slightly different.

You can click the Information button to get more information on the database (via the on-line Help system). Clicking the Continue button places you in the environment of the database itself.

The application window appears as shown in Figure 2.
To begin using the database, simply choose the appropriate item from the menu bar. Some of the menu options (File, Edit, Window, and Help) exhibit few, if any, differences from those options in other applications under the Windows environment. Features that are unique to STEAM are explained in the subsequent sections.

The normal course of action is first to choose units of measure and the desired properties to display; both of these are under the Options menu. Then you choose the type of calculation to perform under the Calculate menu. After performing the calculations, you might want to plot some of the results or to transfer them to another application. The sample session in Appendix A illustrates some of the basic features.
5. OPTIONS AND PREFERENCES

Under the Options menu, you can choose the units of measure you want to work in, the properties you want to display in calculated tables, and some miscellaneous options. All of these options can be saved for use in a later session.

5.1 Specifying Units of Measure

Selecting the Units item in the Options menu brings up the dialog box shown in Figure 3.

Choose the unit of measure to be used for each dimensional quantity in the database by picking the appropriate item in the corresponding list box. At any time you can click the SI or English buttons to reset all the units to either of those predefined sets. You can also choose to have properties that are reported per quantity of fluid displayed on a per mass basis (the default), or a per mole basis. The size of the molar basis is governed by the selection in the Mass list box; selecting “g” uses the standard mole, selecting “kg” uses a kilomole, and selecting “lbm” uses a pound mole.
A change in units of measure is only applicable to calculations in tables generated after the change is made. Existing tables are not affected, and further calculations in an existing table continue to use the set of units in effect when that table was first generated.

5.2 Choosing Properties to Display

Selecting the Properties item in the Options menu brings up the dialog box shown in Figure 4.

![Figure 4. Dialog box for selecting properties to display.](image)

Each of the tabs on the dialog displays a related group of properties; you can choose the properties to be displayed in tables of calculated values by checking and unchecking the corresponding boxes. By default, the properties selected are those shown in Figure 4, as well as the viscosity, thermal conductivity, dielectric constant, and surface tension. As with the Units selection, changing the properties displayed does not affect tables already in existence.

STEAM 6
5.3 Miscellaneous Preferences

Selecting the Preferences item in the Options menu brings up the dialog box shown in Figure 5.

![Preferences dialog box](image)

Figure 5. Dialog box for selecting miscellaneous preferences.

The selection “Copy table headers to clipboard with table data” (unselected by default) places the text in the column headers (both the property name and its units) on the Clipboard, along with the selected data in that column, when you choose Copy from the Edit menu. You should not enable this option if you intend to paste the data into the Selected State Points table, which does not accept text.

The selection “Prompt to save tables and plots when closing” (unselected by default) presents a dialog box allowing you the opportunity to save the window contents to a file before a table or plot window is deleted.

The selection "Add saturation boundaries for isotherms and isobars" (selected by default) causes the saturated liquid and saturated vapor conditions, separated by a horizontal line, to be added to these tables if the range of conditions specified crosses the phase boundary. This is described in Section 6.2.
The selection "Use Enter key to perform calculations for Specified State Points tables" (unselected by default) allows the Enter key to be used to trigger calculations in the tables described in Section 6.3. Normally, the Enter key merely moves the focus to the next row, and one must push the "Calc" button to perform calculations.

The final option in the Preferences dialog allows you to specify the number of digits for the display of all columns of all subsequent tables. This is a shortcut to the normal way of changing the data format by clicking on the heading of each column as described in Section 6.4, which also describes the interpretation of the "digits" value in fixed and floating-point formats. This option can also be applied to existing tables by selecting the check box underneath the field specifying the number of digits.

5.4 Saving and Retrieving Options

The Save Current Options command brings up the usual Windows file save dialog box from which a file name for the current option file can be chosen. Options files are identified by a .PRF filename extension. The choices made in the Units, Properties, and Preferences dialog boxes can be stored in these files. The database reads the DEFAULTS.PRF file at startup. If you want to have the currently selected options appear when the database is started, save them in the DEFAULTS.PRF file. You may save different sets of .PRF files for different uses of the database.

Any set of preferences can be loaded by retrieving the corresponding .PRF file using the Retrieve Options command.
6. GENERATING TABLES OF DATA

The main use of the STEAM database for most users is the generation of property values at specified conditions. These properties are presented in tables. You can generate tables (up to a maximum of 1500 rows) corresponding to saturation conditions, a fixed value of some property, and individual values of two independent variables. All of these calculations are accessed from the Calculate menu.

6.1 Saturation Tables

Selecting the Saturation Tables item in the Calculate menu brings up the dialog box shown in Figure 6.

Figure 6. Saturation Tables dialog box.
Vapor-liquid, solid-liquid (melting), and solid-vapor (sublimation) calculations are available. You may vary either temperature or pressure; for vapor-liquid saturation you may also vary the quality (vapor fraction) at a fixed temperature or pressure. A picture in the dialog box represents the type of calculation chosen. Once you make your selections and click OK, the next dialog asks you to choose a range of conditions to use in the saturation calculations. An example for vapor-liquid saturation at specified temperatures is shown in Figure 7.

![Figure 7. Dialog box for choosing points at which to perform saturation calculations.](image)

For vapor-liquid saturation calculations at fixed temperature or pressure, the resulting table displays the values of each property in the two coexisting phases. For properties (such as fugacity) that are equal in the two phases, only one value is shown. When quality is varied, values for the two-phase mixture are shown; properties not defined in the two-phase region are indicated by an entry of "not applicable". Figure 8 shows a portion of a vapor-liquid saturation table.
For solid/liquid or solid/vapor saturation calculations, the database computes the location of the fluid/solid boundary, but computes properties for only the fluid phase at that boundary. In addition, the database computes the ice form that is in equilibrium with the fluid. Note that for the liquid-solid boundary at a specified temperature, multiple solutions are obtained for some temperatures because the phase boundary between the liquid and Ice I goes down in temperature as the pressure rises. However, as the pressure continues to rise, the equilibrium solid phase then becomes Ice III (and eventually other forms), for which the temperature of the phase boundary goes back up.
Figure 9 shows a portion of a liquid-solid saturation table.

![Figure 9. A portion of a liquid-solid saturation table.](image)

### 6.2 Iso-Property Tables

Selecting the Iso-Property Tables item in the Calculate menu brings up the dialog box shown in Figure 10.

![Figure 10. Iso-Property Tables dialog box.](image)

You can choose which property to hold constant, and whether the pressure or temperature is varied. Combinations that are not single-valued are not allowed. This restriction means that in some cases the selection of a property to hold constant causes either the temperature or pressure button in the “Vary” group to be disabled.

STEAM 12
Once you click OK on your selection, a dialog box appears, such as that shown in Figure 11.

![Dialog box for choosing points for iso-property calculations.](image)

You then choose a fixed value of one variable and a range of values for the other variable.

The resulting table (Figure 12) is similar to that described in the previous section. One additional item, not in the saturation tables, is the Quality (see Appendix B) which in the two-phase region varies from 1.0 for saturated steam to 0.0 for saturated liquid water. For two-phase states, the values displayed for properties that are different in the two phases (such as density) are overall (bulk) values for the two-phase mixture. In order to get values for the coexisting phases, you must compute a saturation table. Some properties (such as the speed of sound) diverge or are not defined in the two-phase region. For these properties “not applicable” is displayed.
Another feature, unique to Iso-Property tables, is triggered when an isotherm or isobar is computed that crosses the vapor-liquid phase boundary. In this case, extra computations are performed at the saturation boundary, and additional rows in the table are added for the saturated vapor and saturated liquid conditions at the boundary. A double-thickness line in the table denotes the phase boundary.

Figure 12 shows part of a table generated for an isobar. This feature may be disabled by unselecting the appropriate check box in the Preferences dialog box, as described in Section 5.3.
6.3 Specified State Points

Selecting the Specified State Points item in the Calculate menu brings up the dialog box shown in Figure 13.

![Specify State Point Table](image)

Figure 13. Specified State Points dialog box.

Here you can choose among several combinations of independent variables for your calculations. Some combinations, such as those which do not make sense, are unavailable. Once you choose one variable, the check boxes corresponding to other variables that are not available in combination with the chosen variable are automatically disabled. In this window, you can also specify the maximum number of separate state points for which calculations are made, thus limiting the number of rows in the resulting table.

Once you click OK in this dialog box, you transfer to the window shown in Figure 14 (for a selection of temperature and pressure as independent variables).
This window has two columns in which you specify values of the selected independent variables. An exception occurs if one of your selections in the previous dialog box was "vapor-liquid saturation," in which case only one column is available for data entry. To enter data, click in any of the cells that say "Enter value" and type in the desired number. To enter a set of regularly incrementing values without typing, click on the arrowhead at the top right of the column in which you want to enter data. The result is a dialog box such as the one shown in Figure 15.
In this dialog box, you specify numbers in specific rows starting at a given value and increasing or decreasing evenly either to some final value, or by some fixed increment, or by a fixed multiplying factor. You can also clear out existing values.

You can paste values in the “Enter value” cells from the clipboard. These values might have been copied from another table in STEAM or from another Windows application.

When all the points are specified, click the Calculate button, and the table fills with calculated values. If you do not fill in the independent variables for some row, that row is skipped. Points in the two-phase region are handled as described in Section 6.2.
Figure 16 shows part of a Specified State Points table after the computations have been performed.

![Figure 16. A portion of a Specified State Points table after calculations.](image)

You can change the value(s) for any independent variable and then recalculate the properties by clicking the Calculate button again. The database recalculates those points for which independent variables have changed.
6.4 Manipulating Data Tables

You can reformat the above tables to suit your needs, by rearranging the columns, and you can change the display format of the numbers in any column. Both of these features are accessed by clicking on the column heading, which brings up a dialog box such as shown in Figure 17.

![Figure 17. Dialog box for moving or reformatting columns.](image)

To change the formatting of the numbers, make a selection in the “Style” list box. In addition to the default format, you can specify display of a fixed number of digits after the decimal point, or display as a floating-point number in exponential notation with a specified number of digits after the decimal point. An example of the currently chosen format is displayed above the Style list box.

You can also move the columns in the table. This is convenient if you want to look at two properties that would normally require scrolling the table between widely separated columns. To move a column, you specify the new column number and click OK. The number of digits displayed may be reset globally in the Preferences dialog as described in Section 5.3.

You can delete a row from a table by choosing the Delete Row command from the Edit menu. This command operates on the table that is currently the topmost window. A dialog box (shown below) asks you to specify the row to be deleted. Note that a row cannot be recovered after it is deleted.
6.5 Warnings and Errors in Calculating Tables

It may happen that you specify one or more conditions for calculation that turn out to be impossible or outside the valid range of the property correlations used. The database displays two different kinds of warnings in such situations, depending on the severity of the problem.

If you request a calculation that the database cannot perform at all (for example, calculation of vapor-liquid saturation at a temperature above the critical temperature), you get a dialog box such as shown in Figure 19.

If you answer “Yes,” the database skips the point which generated
the error and attempts to calculate any remaining points. If you answer “Yes to All,” the warning will be suppressed if it occurs for any of the remaining points in the calculation. If you answer “No,” the database does not attempt to calculate subsequent points. In any case, points that were successfully calculated are displayed in the resulting table.

It may happen that you request a calculation at a condition for which, while the database can generate an answer, a warning is generated. Warning conditions are documented in Appendix C. An example is the property calculations for a supercooled liquid state when the equilibrium state would be a solid phase. In these cases, the database performs all its calculations. At the end, a dialog is displayed such as that shown in Figure 20.

![Figure 20. Example dialog box for warning condition.](image)

In the table itself, the rows that generated warnings are shown in italics. (The entire row is in italics, even though the warning might be generated only because of one property for which the correlation is out of range.) If you click on the row number at the left edge of the table, the warning messages for that particular row are displayed in a dialog box such as that shown in Figure 21.

![Figure 21. Example dialog box displaying warning messages.](image)
7. PLOTS

The STEAM database allows you to plot data you have calculated and also create plots in two predefined formats. While these simple plotting capabilities are adequate for many purposes, the database is not intended to duplicate the features of programs devoted to plotting and data analysis. If you want to make publication-quality plots or perform manipulations on the data, we recommend that you transfer the data from STEAM to such a program. Section 10 of this manual describes how to transfer data to other programs.

7.1 Plotting Data from Tables

Once you have calculated one or more tables, you can choose the New Plot item from the Plot menu, bringing up the dialog shown in Figure 22.

![Figure 22. Dialog box for specifying new plot.](image)

By default, it is assumed that data from the topmost table window are to be plotted. However, the table from which the data are provided can be selected using the drop-down table list at the upper right. It is also assumed by default that all of the data in the table are to be plotted. If this is not the case, it is necessary to enter the starting and stopping row numbers.
The variables to be plotted on the X and Y axes are selected by clicking on their names in the respective lists. Appropriate minimum, maximum, and interval values are supplied as the X and Y variables are selected. However, these values can be changed before the plot is generated by modifying the default values. Other plot options, such as the scale type, the line type, and the plot symbol, can also be selected in this dialog. The smoothing option fits a cubic spline through the data to produce a smooth curve.

The Modify Plot command, available only when one or more plots have already been generated, allows you to change features of an existing plot. Figure 23 shows the Modify Plot dialog box.

![Modify Plot dialog box](image)

Figure 23. Modify Plot dialog box for changing features of existing plot.

Most of the formatting options are identical to those in the New Plot dialog. In addition, you can change the labels on the X and Y axes by typing in the appropriate edit fields or change the font size for the axis labels. You can also delete individual curves from the plot.

You can plot additional data on existing plots by choosing the Overlay Plot command from the Plot menu. The resulting dialog box is identical to the New Plot dialog shown in Figure 22, except that the axis formatting cannot be specified since it is determined by the existing plot. If some of the new data are outside the range of the existing plot, you are prompted about rescaling the axes. It is the user's responsibility to ensure that plots are not overlaid in

STEAM 23
meaningless combinations. In particular, the quantities in the individual data sets plotted should have the same dimensions.

Once a plot is made, it can be resized by using the mouse to move the lower right-hand corner. You can move it around in the plot window by clicking on any other part of the plot and moving the mouse. You can see crosshairs and values corresponding to the X and Y positions of the mouse by depressing the Shift key while the mouse is over the plot. (Use the Shift key to toggle this feature on or off.) Finally, double-clicking on the plot enters the Modify Plot dialog, shown in Figure 23.

You can also add labels to a plot by selecting Add Label from the Plot menu. Figure 24 shows the Add Label dialog in which you may specify the text of the label and choose its size, typeface, and orientation. This dialog can also be used to edit an existing label; simply double-click on the label. Pushing the Delete button will delete the label currently being edited.

Figure 24. Dialog box for adding a label to a plot.
7.2 Predefined Plots

Two special plots are predefined and can be generated on command from the Plot menu: the temperature-entropy (T-s) and pressure-enthalpy (P-h) diagrams. Both plots allow you to define a number of constant-property lines (isobars on the T-s plot, isotherms on the P-h plot) to be plotted. Default values are given, but you can override them. The saturation boundary is automatically plotted. Figure 25 shows the dialog box defining isobars for a T-s plot.

![Enter Isobar Values for T-S Plot](image)

Figure 25. Dialog box for defining a T-s plot.

Once the plot is made, it can be modified with the Modify Plot command.
8. ON-LINE HELP

On-line help is available under the Help menu. The Help Index selection gives an index from which explanations of how to use all the database’s functions can be reached. The Using Help selection explains how to use the Help system itself. The About selection takes you to the same informational window that appears when the database starts.

You can also access Help from an individual dialog box. If you press F1, you are placed in the Help system at the point containing instructions for the use of that dialog box.
9. SAVING YOUR WORK

You may wish to save some calculated tables or plots and come back to them later for further work. This is done with the Save Session command in the File menu. The Save Session command allows you to give the saved session a name by which you can retrieve it later. These saved sessions are identified by a .STM file extension. All information from the currently active session is saved; not only the tables and plots but also any Units, Properties, and Preferences set under the Options menu.

You can retrieve a previously saved session with the Open Session command under the File menu. This command is only available if no tables or plots are currently open; if some are open they must be closed (either individually or by using the Close Session command, see below) before another session can be opened.

The Close Session command (also under the File menu) closes all tables and plots. If the “Prompt to save tables and plots when closing” item is selected in the Preferences (see Section 5.3), you will be prompted as to whether you want to save the current session for later retrieval. Any settings of Units or other options are retained and will still be in effect if you do further calculations. If you wish to recover the default options, you can retrieve the DEFAULTS.PRF file as described in Section 5.4.

You can also save your work in other formats by transferring the data to other applications or saving it to disk; that is described in Section 10.
10. EXCHANGING DATA WITH OTHER APPLICATIONS

You can copy and paste data from tables both within the NIST/ASME Steam Properties Database and between the database and other applications. To select a block of data in a table, click the cell at one corner of the block you want to select. Then press shift and click at the diagonally opposite corner of the block. You can also select a block by dragging the mouse over it while depressing the Shift key. [NOTE: This is similar to selecting cells in most spreadsheet applications, except that in this database you must hold down the Shift key.] You can also select the entire table by choosing the Select All item from the Edit menu. Once a block is selected, you can copy it onto the clipboard by using the Copy Table Data command under the Edit menu. It is then available to be pasted into another table or application. Only the digits displayed in the table are copied; additional precision beyond that displayed is lost. You can also copy a plot onto the clipboard by clicking on it and selecting Copy Plot.

In a Specified State Points table, you may want to paste in values for one or both of your independent variables rather than typing them in. To paste data from the clipboard, click in the top-left cell of the area into which you want to paste. Then choose Paste from the Edit menu. If you attempt to paste non-numerical data into a table, the database tells you that such input is not allowed (for example, the data column headings in data copied from a table with the “Copy table headers to clipboard” option in the Preferences dialog under the Options menu).

You can also save tables (as ASCII text) to a file by choosing the Save Tables command under the File menu. The resulting dialog prompts you to specify the tables to be saved, whether to include the column headings, and what to use as delimiters between columns. You are then prompted for the filename in which to save the table. This feature is useful if you want to transfer information to another application at a later time.

If you have purchased STEAM in a form that includes the source code, you can use the calculation routines from the STEAM database directly inside your own program or build them into a dynamic link library (DLL) to be called from another application. Instructions for how to do this are given in Appendix D.
Appendix A
SAMPLE SESSION

This example demonstrates the use of the NIST/ASME Steam Properties database to compute and plot the vapor pressure and fugacity at saturation (in units of bars) as a function of temperature. The temperature range is 100 to 350 °C.

To start, double-click on the STEAM icon or the Windows Explorer to go to the application and double-click on it. Another way to start the database is to go to the Start button and choose the database under the Programs option.

First, choose the Units item from the Options menu. Click on the Temperature drop-down list box and choose C. (In this appendix, italics indicate the button to be clicked on or the selection to be made.) Click on the Pressure drop-down list box and choose bar. Click OK. Now any calculations you make are displayed in those units.

Next, choose Saturation Tables from the Calculate menu. The resulting dialog box is used to specify the type of saturation calculation. Because the default selection is vapor-liquid saturation at specified temperatures, simply click OK. The next window is for entering the set of conditions for the calculations (in this case, the series of temperatures for which property data are desired.) Enter 100 for the initial temperature and 350 for the final temperature. Change the increment to 10 degrees. Click OK. The database performs calculations and produces a table, the initially visible portion of which is shown in Figure A-1.
Figure A-1. Table produced in sample session.

It is possible either to begin plotting immediately or to examine and revise the table. In this example, we want to change the format of the table so that the fugacity is displayed next to the pressure. This involves moving column 20 (fugacity) to column 3. Scroll the table over to the fugacity column and click in the header at the top of the column. Change the setting of the "Move to column" item from 20 to 3, and click OK. Scroll the table back to the beginning, and note that the fugacity is now in column 3. The visible portion of the table now looks like Figure A-2.
Figure A-2. Table produced in sample session after rearrangement of columns.

To begin plotting, select New Plot from the Plot menu. By default, the Temperature column is selected as the X-axis and the Pressure column as the Y-axis. The other settings are also appropriate, so click OK. The result is a plot of pressure as a function of temperature. To plot the fugacity on the same graph, select Overlay Plot from the Plot menu. Keep temperature as the X-axis and choose fugacity as the Y-axis. To distinguish the two graphs more easily, choose the solid circle from the Symbol drop-down list. Click OK. The resulting plot has two superimposed graphs. Note that (because of roundoff) the X-axis has been scaled from 50 to 350 rather than 100 to 350. To fix this, double-click on the plot to reach the Modify Plot dialog box. Go to the X-axis section and change the Minimum entry to 100. Click OK. The final plot should appear as shown in Figure A-3.

<table>
<thead>
<tr>
<th></th>
<th>Temperature [°C]</th>
<th>Pressure [bar]</th>
<th>Fugacity [bar]</th>
<th>Density (l) [kg/m³]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>100.00</td>
<td>1.014</td>
<td>0.9930</td>
<td>953.3</td>
</tr>
<tr>
<td>2</td>
<td>110.00</td>
<td>1.434</td>
<td>1.407</td>
<td>950.9</td>
</tr>
<tr>
<td>3</td>
<td>120.00</td>
<td>1.887</td>
<td>1.941</td>
<td>943.1</td>
</tr>
<tr>
<td>4</td>
<td>130.00</td>
<td>2.703</td>
<td>2.527</td>
<td>934.8</td>
</tr>
<tr>
<td>5</td>
<td>140.00</td>
<td>3.815</td>
<td>3.494</td>
<td>928.1</td>
</tr>
<tr>
<td>6</td>
<td>150.00</td>
<td>4.752</td>
<td>4.571</td>
<td>917.0</td>
</tr>
<tr>
<td>7</td>
<td>160.00</td>
<td>6.182</td>
<td>5.391</td>
<td>907.4</td>
</tr>
<tr>
<td>8</td>
<td>170.00</td>
<td>7.422</td>
<td>7.487</td>
<td>897.5</td>
</tr>
<tr>
<td>9</td>
<td>180.00</td>
<td>10.03</td>
<td>9.363</td>
<td>887.0</td>
</tr>
<tr>
<td>10</td>
<td>190.00</td>
<td>12.56</td>
<td>11.64</td>
<td>878.1</td>
</tr>
<tr>
<td>11</td>
<td>200.00</td>
<td>15.55</td>
<td>14.27</td>
<td>864.7</td>
</tr>
</tbody>
</table>
Figure A-3. Plot produced in sample session.
Appendix B

INFORMATION ON PROPERTY COMPUTATIONS

Fluid Thermodynamic Properties

In the NIST/ASME Steam Properties database, Version 2.22, the equilibrium thermodynamic properties for water are calculated from the 1995 Formulation for the Thermodynamic Properties of Ordinary Water Substance for General and Scientific Use, issued by the International Association for the Properties of Water and Steam (IAPWS) [1,2].

The formulation consists of a fundamental equation for the Helmholtz energy per unit mass (kg), made dimensionless by $R_m T$, (where $R_m$ is a mass-based gas constant and $T$ is the temperature), as a function of temperature and density. When combined with a function for the ideal gas Helmholtz energy [3], a complete Helmholtz energy surface is defined. All other thermodynamic properties can then be obtained by differentiation of this surface. Conditions of vapor-liquid equilibrium can be established by finding a pressure where, at the given temperature, the vapor and liquid densities produce not only that pressure, but also identical fugacities.

Some properties may be reported on either a mass or molar basis. The basic formulation is in terms of mass; conversion to moles is performed using a molar mass of 18.015268 g/mol. This molar mass corresponds to that of Vienna Standard Mean Ocean Water (VSMOW), which is an internationally recognized standard for the isotopic composition of water [4-7].

Some properties (such as isobaric heat capacity, isothermal compressibility, speed of sound, and Joule-Thomson coefficient) are not defined in the two-phase region. Therefore, calculations at a two-phase condition produce a result of “not applicable” for these properties.

All thermodynamic properties that can be computed by the database are listed below, with comments when needed for clarification. Definitions for most of these quantities may be found in [8].
Temperature

Temperatures are on the International Temperature Scale of 1990 [9].

Pressure

Density

Volume

Quality

For a two-phase condition, quality is defined as the amount of water in the vapor phase divided by the total amount of water. For the saturated liquid and saturated vapor, the quality is 0.0 and 1.0, respectively. One-phase fluids that are subcooled or superheated are so designated. If the pressure is above the critical pressure (22.064 MPa), there is no rigorous definition of these terms; the database designates the fluid as "superheated" if the temperature is above the critical temperature and "subcooled" if it is below.

Enthalpy

The zero for the enthalpy function is determined by the conventions (see below) that the entropy and internal energy functions are zero for the saturated liquid at the triple point.

For the enthalpy and other quantities containing dimensions of energy, varying definitions are sometimes used for the non-SI units of calories and Btu's. When those units are used in this database, the conversion to and/or from SI units is based on the International Table calorie, defined by the Fifth International Conference on the Properties of Steam to be exactly 4.1868 joules. The corresponding International Table Btu is approximately 1055.056 joules. These values differ slightly from other common definitions, such as the "thermochemical" calorie which is defined as 4.184 joules.

STEAM 34
Entropy

The arbitrary zero for the entropy function is chosen to be the saturated liquid at the triple point. Together with the internal energy zero, this defines the scale for the enthalpy, Helmholtz energy, and Gibbs energy.

Isochoric Heat Capacity

The isochoric (constant-volume) heat capacity is defined by:

\[
c_v = \left( \frac{\partial u}{\partial T} \right)_V
\]

where \( u \) is the internal energy per unit mass.

For states within the two-phase region, this property exists (as opposed to the constant-pressure heat capacity, which is divergent), but requires a more complicated calculation than for the one-phase region. The basic equation is:

\[
c_v = \left( \frac{\partial u}{\partial T} \right)_{\text{sat}} + (1 - Q) \left( \frac{\partial u}{\partial T} \right)_{\text{sat}} + \left( \frac{\partial Q}{\partial T} \right)_V \Delta u^\text{vap}
\]

where \( Q \) is the quality, \( u_v \) and \( u_l \) are the internal energy of the saturated vapor and liquid, respectively, and \( \Delta u^\text{vap} \) is the internal energy change of vaporization. Subscripts \( \text{sat} \) and \( V \) indicate derivatives evaluated under the constraint of vapor-liquid saturation and at constant volume, respectively. Evaluation of the derivatives in the above equation makes use of other calculated quantities such as the heat capacities, densities and volume expansivities of the individual phases, and the slope of the vapor-pressure curve with respect to temperature.
Isobaric Heat Capacity

The isobaric (constant-pressure) heat capacity is defined by:

\[ c_p = \left( \frac{\partial h}{\partial T} \right)_p \]

where \( h \) is the enthalpy per unit mass.

Internal Energy

The arbitrary zero for the internal energy function is chosen to be the saturated liquid at the triple point (273.16 K, 611.657 Pa).

Helmholtz Energy

Gibbs Energy

Fugacity

Isothermal Compressibility

This quantity, often written as \( \kappa_T \), is defined by:

\[ \kappa_T = -\frac{1}{V} \left( \frac{\partial V}{\partial p} \right)_T \]
Volume Expansivity

This quantity, often written as $\alpha$, is defined by:

$$\alpha = \frac{1}{V} \left( \frac{\partial V}{\partial T} \right)_p$$

Isothermal $dp/d\rho$

Isochoric $dp/dT$

Speed of Sound

Joule-Thomson Coefficient

This coefficient, often written as $\mu$, is defined by:

$$\mu = \left( \frac{\partial T}{\partial p} \right)_h$$

Additional Derivatives

The database can also calculate several additional derivatives of the equation of state. These are the second derivatives of pressure as a function of temperature and density, and the first and second derivatives of density as a function of temperature and pressure.
Transport Properties

Calculations for the thermal conductivity are based on a formulation adopted by IAPWS (then IAPS) in 1985 [10]. That formulation is slightly outdated, because it does not correspond to the 1990 temperature scale and makes use of an isothermal compressibility computed from an obsolete water equation of state. In this revised implementation, adopted by IAPWS in 1998, we use the same equations with temperatures on the 1990 scale with the compressibility calculated from the 1995 IAPWS formulation for thermodynamic properties [1,2].

Calculations for the viscosity are based on a new formulation adopted by IAPWS in 2008 [11,12]

Surface Tension

The vapor-liquid surface tension is calculated according to the IAPWS 1994 formulation for the Surface Tension of Ordinary Water Substance [13]. Note that the table of surface tension values (Table 1) given in this reference is incorrect, but the surface tension formula is correct.

Dielectric Constant

The static dielectric constant (or relative permittivity, where the permittivity of a vacuum is defined to be unity) is correlated as a function of temperature and density [14]. This formulation contains a singularity at the temperature of 228 K; calculations at or below that temperature (which is only possible for vapors at extremely low pressures) return a value of "not applicable" for the dielectric constant.

The database also calculates several derivatives of the dielectric constant. These are the first derivative with respect to density at constant temperature, the first derivative with respect to temperature at constant density, and the first and second derivatives as a function of pressure and temperature.
Debye-Hückel Slopes

The so-called Debye-Hückel slopes are used by solution chemists to describe the contributions of electrostatic effects to the thermodynamic properties of ionic solutions. Definitions of these quantities may be found in [14]. This database computes the Debye-Hückel slopes for activity coefficient, osmotic coefficient, apparent molar volume, apparent molar enthalpy, apparent molar compressibility, and apparent molar heat capacity.

Refractive Index

The refractive index (relative to a vacuum) is computed as a function of temperature, density, and wavelength according to a formulation adopted by IAPWS [15]. This correlation is primarily intended for wavelengths in the visible region, but also extends somewhat into the ultraviolet and the near infrared.

Solid Phase Boundaries

This database does not compute any properties of the solid phases of water. However, it does give the conditions at which solid and fluid are in equilibrium. The database also gives the ice form in equilibrium with the fluid at a given condition. The vapor-solid and liquid-solid boundaries are given by the formulas adopted by IAPWS in 2008 [16].
Uncertainties in Calculated Properties

The properties calculated by this database have associated uncertainties, arising from the precision and scatter of the underlying experimental data and from the fit of the formulation to those data. In general, information about these uncertainties may be found in the IAPWS release document for the property in question. However, since the thermodynamic properties are of interest to the most users and their uncertainties have been conveniently summarized in graphical form, we present here four figures, taken from the IAPWS release [1], which show the uncertainties for key thermodynamic properties as a function of pressure and temperature.

Figure B-1. Estimated uncertainties in density. In the enlarged critical region (triangle), a percent uncertainty in pressure is given. This region is bordered by the two isochores 527 kg·m⁻³ and 144 kg·m⁻³ and by the 30 MPa isobar. The positions of the lines separating the uncertainty regions are approximate.
Figure B-2. Estimated uncertainties in speed of sound. For the definition of the region around the critical point, see Figure B-1. The positions of the lines separating the uncertainty regions are approximate.
Figure B-3. Estimated uncertainties in isobaric heat capacity $c_p$. For the definition of the region around the critical point, see Figure B-1. The positions of the lines separating the uncertainty regions are approximate.
Figure B-4. Estimated uncertainties in vapor pressure $p_m$, saturated liquid density $\rho'$, and saturated vapor density $\rho''$. 
References


Appendix C
INFORMATION ON WARNING AND ERROR LIMITS

All formulations used within the NIST/ASME Steam Properties database have a specified region of validity. In addition, most of them can be extrapolated to some extent without producing unreasonable results. Two different levels of boundaries are therefore incorporated in the software. The first level is the actual region of validity of the formulation. Calculations outside those boundaries still produce a result, but also produce a warning message. The second level are the boundaries beyond which no calculations are allowed. These boundaries are usually set because the calculations would be physically meaningless, or because computational problems would be encountered. The following sections describe the boundaries for various calculations.

Thermodynamic Properties
The formulation is recommended for temperatures between 273.15 K and 1273.15 K and for all positive pressures up to 1000 MPa. The absolute limits (beyond which no calculations are made) are temperatures of 130 K and 5000 K and a pressure of 1.0x10^5 MPa. To avoid computational problems, a lower pressure limit of 1.0x10^-20 MPa is also set. There is also a warning region very close to the critical point, which is discussed separately below.

Transport Properties
The absolute limits for transport properties are the same as for the thermodynamic properties. The recommended validity range for the viscosity calculations is as follows:

\[

t_{273.16} \leq T \leq t_{1173.15} \text{ K for } 0 < p < p_t \\
T_m(p) \leq T \leq t_{1173.15} \text{ K for } p_t \leq p \leq 300 \text{ MPa} \\
T_m(p) \leq T \leq t_{873.15} \text{ K for } 300 \text{ MPa} < p \leq 350 \text{ MPa} \\
T_m(p) \leq T \leq t_{433.15} \text{ K for } 350 \text{ MPa} < p \leq 500 \text{ MPa} \\
T_m(p) \leq T \leq t_{373.15} \text{ K for } 500 \text{ MPa} < p \leq 1000 \text{ MPa}
\]

where \( p_t \) is the triple-point pressure and \( T_m(p) \) the pressure-dependent melting temperature, as given in [16].
The recommended validity range for the thermal conductivity calculations is:

\[ 273.15 \text{ K} \leq T \leq 1073.15 \text{ K} \quad \text{for} \quad p \leq 100 \text{ MPa} \]
\[ 273.15 \text{ K} \leq T \leq 673.15 \text{ K} \quad \text{for} \quad 100 \text{ MPa} < p \leq 150 \text{ MPa} \]
\[ 273.15 \text{ K} \leq T \leq 523.15 \text{ K} \quad \text{for} \quad 150 \text{ MPa} < p \leq 200 \text{ MPa} \]
\[ 273.15 \text{ K} \leq T \leq 398.15 \text{ K} \quad \text{for} \quad 200 \text{ MPa} < p \leq 400 \text{ MPa} \]

Dielectric Constant

The absolute limits for the dielectric constant calculations are the same as for the thermodynamic properties, except that the lower temperature limit is 238 K. The recommended range is temperatures from 238 to 873 K at pressures up to 1000 MPa.

Refractive Index

The absolute limits for the refractive index calculations are the same as for the thermodynamic properties. The recommended range is temperatures from 261.15 K to 773.15 K at densities up to 1060 kg/m³. There are also limits on the wavelength of light at which the refractive index may be computed. The recommended range is from 0.2 μm to 1.1 μm. The absolute limits are from 0.18 μm to 1.9 μm.

Solid Phase Boundaries

If fluid phase calculations are requested in a region in which the actual equilibrium phase would be a solid (for example, for a supercooled liquid), a warning message is issued. If the temperature is more than 35 K below the fluid-solid saturation boundary at that pressure, no calculations are performed.
Near-Critical Region

The 1995 IAPWS formulation for thermodynamic properties is known to give unphysical behavior for some of the “derivative” properties (specifically, the isothermal compressibility, the isochoric and isobaric heat capacities, and the speed of sound) in a region very close to the critical point. Property calculations in that region are therefore accompanied by a warning. The region is defined by:

\[ 647.076 \text{ K} < T < 652.096 \text{ K} \quad \text{for} \quad 320.39 \text{ kg/m}^3 < \rho < 323.61 \text{ kg/m}^3 \]

Vapor-Liquid Saturation

Vapor-liquid saturation calculations are only valid for temperatures and pressures from the triple point (273.16 K, 611.657 Pa) to the critical point (647.096 K, 22.064 MPa). In addition, numerical limitations prevent solving exactly for the saturation conditions very near the critical point. In that case, a warning is issued, and the saturation pressure and coexisting densities are given based on an interpolation constrained to give the correct values for pressure (22.064 MPa) and density (322 kg/m³) at the critical point. This warning should rarely be encountered; the software is able to solve rigorously for vapor-liquid coexistence at temperatures up to approximately 647.09599 K.

The database also allows calculations of the vapor-liquid saturation boundary extrapolated below the triple point, down to a temperature of 253.15 K. A warning is issued if calculations are performed in this region.

Surface Tension

The surface tension formulation is valid from the triple point to the critical point. For the extrapolated vapor-liquid boundary below the triple point, the surface tension formulation is extrapolated and a warning is issued.
Appendix D

INCORPORATING STEAM ROUTINES INTO OTHER PROGRAMS

If you have purchased a version of the NIST/ASME Steam Properties Database that includes source code, you can directly access all of the calculations performed by the database by calling the appropriate subroutines. You can incorporate the subroutines directly into your own computer program. You can also make a dynamic link library (DLL) to be accessed by another application. The details of these procedures vary depending on what compiler and potentially what other application you are using. Questions about constructing DLL's, etc. should be addressed to the suppliers of those products rather than to NIST. The purpose of this Appendix is to provide general information about accessing steam properties directly from the subroutines.

All the source code for the calculations is written in the Fortran 77 language and is compatible with Fortran 90 and Fortran 95. The Fortran source code is divided into five sets of subroutines, as follows:

- **AUXPK.FOR**  
  Miscellaneous subroutines used in the calculations

- **EOSPK.FOR**  
  Subroutines used to evaluate the fundamental equation of state

- **INTPK.FOR**  
  “Interface” subroutines which accept input in SI units, call the appropriate routines and return values in SI units. **The subroutines in INTPK are the only ones that should ever be called from another program.**

- **PROPPK.FOR**  
  Subroutines to calculate various fluid properties.

- **SOLVPK.FOR**  
  Subroutines to solve various sets of conditions, such as finding the vapor pressure at a given temperature.
There are also five common blocks used by the subroutines: COEF.CMN, COEFIG.CMN, NPROP.CMN, WCONST.CMN, and WLIMIT.CMN. These common blocks must be accessible by INCLUDE statements whenever a subroutine is compiled. This is most easily accomplished by putting them in the same directory as the source routine.

All calculations should be performed by calling the appropriate subroutine in INTPK. You should not need to call directly any subroutine in any of the other sets of subroutines. Those subroutines should simply be compiled as is and linked in with the program.

Interface Subroutines

INTPK.FOR contains twelve subroutines through which the STEAM database communicates with the outside world. Here, we list the subroutines and document their argument lists. Note that many of the arrays passed to these routines have a dimension of NPROP, where NPROP (the length of the property array) is set in NPROP.CMN. NPROP.CMN also contains the dimension NRIMAX, which is the maximum number of wavelengths at which the refractive index may be calculated and is needed for some arrays passed to the PROPS subroutine.

The “TYPE” of each argument is R (double precision real), I (integer), RA (double precision real array), or IA (integer array). The “I/O” column tells whether an argument is input (I) to the subroutine or output (O) from the subroutine. In a few cases a dash appears; this indicates an argument that is used only as internal workspace by the routine.
**BNDCK**: Checks to see if conditions are outside of warning and/or error limits.

```fortran
SUBROUTINE BNDCHK(TK, PMPA, RHO, MODE, ISCHK, ISFLG, ICCHK, ICFLG, 
                   IPCHK, IPFLG, IWORK, PROPSI, RWORK)

C CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC

*** BNDCHK ***                                    C
C THIS ROUTINE CHECKS TO SEE IF THE REQUESTED POINT IS AN C
C EXTRAPOLATION OR OUT OF RANGE FOR A VARIETY OF CRITERIA C
C
C ARGUMENT LIST:                                      C
C NAME  TYPE I/O? EXPLANATION                         C
C ------ ---- ---- ---------------------------------------------------
C TK      R    I   TEMPERATURE IN KELVINS                  C
C PMPA    R    I   PRESSURE IN MPA                        C
C RHO     R    I   DENSITY IN KG/M3                       C
C MODE    I    I   TELLS WHAT INFORMATION IS AVAILABLE ON C
                   ENTRY
C                  0: T, P, RHO ALL KNOWN                  C
C                  1: T AND P KNOWN, RHO UNKNOWN            C
C                  2: T AND RHO KNOWN, P UNKNOWN            C
C *** NOTE: FOLLOWING ARE FLAGS FOR WHETHER TO MAKE A CHECK (1=CHECK, C
C           0=DON'T) AND FLAGS RETURNED FROM THE CHECKS (0=OK OR NOT C
C           CHECKED, 1=EXTRAPOLATED BEYOND RECOMMENDED REGION, 2= C
C           UNACCEPTABLY OUTSIDE OF REGION                  C
C ISCHK   I    I   WHETHER TO CHECK IF EQUILIBRIUM PHASE IS SOLID C
C ISFLG   I    O   RESULT OF SOLID CHECK                   C
C ICCHK   I    I   WHETHER TO CHECK IF TOO NEAR CRITICAL POINT C
C ICFLG   I    O   RESULT OF NEAR-CRITICAL CHECK           C
C IPCHK   IA   I   WHETHER TO CHECK BOUNDARIES FOR VARIOUS C
                   PROPERTIES.                                        C
C                   ARRAY ELEMENTS ARE: 1: THERMODYNAMIC PROPERTIES C
C                   2: VISCOSITY                               C
C                   3: THERMAL CONDUCTIVITY                    C
C                   4: DIELECTRIC CONSTANT                    C
C                   5: REFRACTIVE INDEX                       C
C IPFLG   IA   O   RESULTS OF PROPERTY BOUNDARY CHECKS     C
C IWORK   IA   -   INTEGER WORK ARRAY, USED IF P GETS CALCULATED C
C PROPSI  RA   O   VECTOR OF PROPERTIES IN SI UNITS AS REQUESTED BY C
                   IWANT.  NUMBERING OF PROPERTIES:                   C
C                  2: PRESSURE IN MPA                        C
C RWORK   RA   -   REAL WORK ARRAY, USED IF P GETS CALCULATED C

C CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC
```

**DENS, DENS0**: Solve for density given T and P. DENS requires an initial guess.

```fortran
SUBROUTINE DENS(DOUT, PMPA, D, TK, DPD, IWORK, PROPR, IERR)

C CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC

*** DENS ***                                    C
C THIS ROUTINE FINDS THE DENSITY (IN KG/M3) CORRESPONDING TO A GIVEN C
C TEMPERATURE TK (IN K) AND PRESSURE PMPA (IN MPA). AN C
C INITIAL GUESS (D) IS REQUIRED, AND THE VALUE OF DPD IS ALSO C
C RETURNED.                                      C
C
C ARGUMENT LIST:                                  C
C NAME  TYPE I/O? EXPLANATION                     C
C ------ ---- ---- ---------------------------------------------------
C DOUT    R   O   DENSITY AT TK AND PMPA, KG/M3      C
C PMPA    R   I   PRESSURE, MPA                     C
C D       R   I   INITIAL GUESS FOR DENSITY, KG/M3   C
C TK      R   I   TEMPERATURE, K                     C
C DPD     R   O   FIRST DERIVATIVE OF PMPA WITH RESPECT TO D AT DOUT C
```
SUBROUTINE DENS0(DOUT, PMPA, TK, DPD, IWORK, PROPR, IERR)

C THIS ROUTINE FINDS THE DENSITY (IN KG/M3) CORRESPONDING TO A GIVEN C
C TEMPERATURE (IN K) TK AND PRESSURE (IN MPA) PMPA. IN C
C CONTRAST TO DENS, NO INITIAL GUESS IS REQUIRED (ONE IS GENERATED C
C INTERNALLY). THE VALUE OF DPD IS ALSO RETURNED. C

C NAME TYPE I/O? EXPLANATION
C ------ ---- ---- ------------------------------------------------
C DOUT R O DENSITY AT TK AND PMPA, KG/M3 C
C PMPA R I PRESSURE, MPA C
C TK R I TEMPERATURE, K C
C DPD R O FIRST DERIVATIVE OF PMPA WITH RESPECT TO D AT DOUT C
C IWORK IA - INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES C
C PROPR RA - VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL C
C ROUTINES C
C IERR I O DFIND0 RETURN STATUS FLAG. NEGATIVES FROM DFIND1, C
C POSITIVES FROM DFIND2. MEANINGS: C
C 0: CONVERGED C
C -2: UNABLE TO BOUND ROOT (DFIND1) C
C -3: UNABLE TO CONVERGE BOUNDED ROOT (DFIND1) C
C 1: NO ROOT FOR REQUESTED PHASE. RETURNS D WHERE C
C DPD = 0 (DFIND2) C
C 2: UNABLE TO BOUND ROOT (DFIND2) C
C 3: UNABLE TO CONVERGE BOUNDED ROOT (DFIND2) C
C 5: INPUT PRESSURE NOT IN VALID RANGE C
C 6: INPUT TEMPERATURE NOT IN VALID RANGE C
C 7: INPUT T,P TOO FAR IN SUBCOOLED SOLID REGION. C
C CALCULATIONS ABORTED C

SUBROUTINE DENS0(DOUT, PMPA, TK, DPD, IWORK, PROPR, IERR)
HSSOLV: Solve for temperature given pressure and entropy or enthalpy; solve for pressure given temperature and entropy.

SUBROUTINE HSSOLV(MODE, TP, HS, TPOUT, D1, DV, DL, I2PH, Q, > IWORKE, PROPR, IERR)

C THIS ROUTINE SOLVES FOR THE CORRESPONDING T OR P FOR SPECIFIED
C P/H, P/S, OR T/S. IT ALSO RETURNS THE DENSITY AT THE SOLUTION (OR
C DENSITIES FOR 2-PHASE SOLUTION) AND QUALITY. THE ROUTINES THAT IT
C CALLS GET PASSED LIMITS WHICH ARE CHECKED.

C ARGUMENT LIST:
C NAME TYPE I/O? EXPLANATION
Cmode I I 1 = GIVEN P/H, SOLVE FOR T
C          2 = GIVEN P/S, SOLVE FOR T
C          3 = GIVEN T/S, SOLVE FOR P
Ctp  R I DEPENDING ON MODE, EITHER T(K) OR P(MPA)
C   hs  R I DEPENDING ON MODE, EITHER H(KJ/KG) OR S (KJ/KG.K)
C    tpoout  R O SOLUTION FOR T(K) OR P(MPA)
C     d1  R O DENSITY (KG/M3) IF SOLUTION IN 1-PHASE REGION
C     dv  R O VAPOUR DENSITY (KG/M3) IF SOLUTION IN 2-PHASE REGION
C     dl  R O LIQ. DENSITY (KG/M3) IF SOLUTION IN 2-PHASE REGION
C    i2ph I O OUTPUT FLAG FOR RELATION TO 2-PHASE REGION
C         0 = NO SOLUTION FOUND
C         1 = SUBCOOLED LIQUID (ALSO T<TC AND P>PC)
C         2 = SUPERHEATED VAPOR (ALSO T>TC)
C         3 = SOLUTION IN TWO-PHASE REGION
C         4 = SAME AS 2, EXCEPT 2-PHASE ENVELOPE EXTRAPOLATED
C         5 = SOLUTION IN TWO-PHASE REGION ACCEPTED AS SUCH;
C         6 = SOLUTION IN TWO-PHASE REGION ACCEPTED AS SUCH
C           LESS LIQUID
C     q  R O QUALITY (VAPOR/TOTAL) AT SOLUTION. IF SOLUTION IS
C         1-PHASE, RETURNS 1.0 FOR SUPERCRITICAL ISOBAR OR
C         ISOTHERM. FOR 1-PHASE ON SUBCRITICAL ISOBAR OR
C         ISOTHERM, RETURNS 1.0 FOR VAPOR OR 0.0 FOR LIQUID.
C    iworce IA - INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES
C    propr ra - VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL
C    routines
C    ierr I O RETURN STATUS CODE
C         0: CONVERGED
C         1: NO SOLUTION INSIDE VALID RANGE
C         2: SOLUTION EXTRAPOLATED OUTSIDE RECOMMENDED RANGE
C         3: UNABLE TO CONVERGE BOUNDED ROOT
C         4: SOLUTION EXTRAPOLATED OUTSIDE RECOMMENDED RANGE
C         5: INPUT PRESSURE NOT IN VALID RANGE
C         6: INPUT TEMPERATURE NOT IN VALID RANGE
C         7: CALLED WITH INVALID MODE
PMELT, TMELT: Solve for liquid-solid saturation (melting) curve.

SUBROUTINE PMELT(TK, NROOTS, PMPA1, PMPA2, IFORM, IERR)

THIS ROUTINE GIVES THE MELTING PRESSURE(S) PMPA AS A FUNCTION OF TEMPERATURE TK USING THE IAPWS 2008 EQUATIONS. ALL FORMS OF ICE ARE CONSIDERED, SO IT IS POSSIBLE TO HAVE TWO ROOTS.

ARGUMENT LIST:

NAME TYPE I/O? EXPLANATION
----- ---- ---- ------------------------------------------------
TK R I TEMPERATURE IN K
NROOTS I O NUMBER OF PRESSURES AT WHICH MELTING HAPPENS AT TK
PMPA1 R O MELTING PRESSURE IN MPA FOR FIRST ROOT, IF ANY
PMPA2 R O MELTING PRESSURE IN MPA FOR SECOND ROOT, IF ANY
IFORM I O FORM OF ICE WITH WHICH FLUID COEXISTS. IF NROOTS IS 2, THIS CONTAINS THE HIGH-PRESSURE FORM SINCE ROOT 1 MUST BE ICE I.
IERR I O RETURN CODE:
  0 = SUCCESS
  1 = TEMPERATURE BELOW VALID RANGE (251.165 K)
  2 = TEMPERATURE ABOVE VALID RANGE (715. K)

SUBROUTINE TMELT(TK, PMPA, IFORM, IERR)

THIS ROUTINE GIVES THE MELTING TEMPERATURE TK AS A FUNCTION OF PRESSURE PMPA USING THE IAPWS 2008 EQUATIONS. IT ITERATIVELY CALLS PMELT1 (FOR ICE I) OR PMELT2 (FOR HIGH-PRESSURE FORMS).

ARGUMENT LIST:

NAME TYPE I/O? EXPLANATION
----- ---- ---- ------------------------------------------------
TK R O MELTING TEMPERATURE IN K
PMPA R I PRESSURE IN MPA
IFORM I O NUMBER OF ICE FORM INVOLVED IN THE EQUILIBRIUM
IERR I O RETURN CODE:
  0 = SUCCESS
  1 = PRESSURE BELOW VALID RANGE (611.657D-6 MPA)
  2 = PRESSURE ABOVE VALID RANGE (20618 MPA)

STEAM 54
PROPS: Compute fluid properties at a given temperature and density.

SUBROUTINE PROPS(IWANT, TK, RHO, PROPSI, PROPR, I2PHCK, I2PH,
             > ISCHR, ISFLG, ICHR, IFCHR, IFPLG, ISFLG,
             > NRI, WAVRI, RI, IRIFLG)

C THIS ROUTINE COMPUTES ALL PROPERTIES REQUESTED VIA THE IWANT VECTOR.
C AT A GIVEN TEMPERATURE AND DENSITY. PROPERTIES ARE RETURNED IN SI UNITS:
C KG, M^3, K, MPA, KJ. THE LOWER-LEVEL ROUTINE PROPS1 IS CALLED TO RETURN
C THE PROPERTIES. IT ALSO CHECKS TO SEE IF THE POINT IS IN THE 2-PHASE
C REGION AND RETURNS THE APPROPRIATE QUALITY AND BULK PROPERTIES. BOUNDS
C CHECKING IS ALSO DONE HERE IF REQUESTED.
C
C ARGUMENT LIST:
C NAME TYPE I/O? EXPLANATION
C ------ ---- ---- -------------------------------------------------
C IWANT IA I FOR WHETHER OR NOT TO COMPUTE VARIOUS PROPERTIES,
C SEE PROPSI ARRAY BELOW FOR NUMBERING OF PROPERTIES
C 1=COMPUTE, 0=DON'T COMPUTE
C TK  R  I TEMPERATURE IN KELVINS
C RHO  R  I DENSITY IN KG/M^3
C PROPSI RA O VECTOR OF PROPERTIES IN SI UNITS AS REQUESTED BY
C IWANT. NUMBERING OF PROPERTIES:
C 1: TEMPERATURE IN K
C 2: PRESSURE IN MPA
C 3: DENSITY IN KG/M^3
C 4: VOLUME IN M^3/KG
C 5: QUALITY (ONLY SET IF 2-PHASE)
C 6: ENTHALPY IN KJ/KG
C 7: ENTHALPY IN KJ/(KG*K)
C 8: ISOCORIC HEAT CAPACITY IN KJ/(KG*K)
C 9: ISOBARIC HEAT CAPACITY IN KJ/(KG*K)
C 10: INTERNAL ENERGY IN KJ/KG
C 11: HELMHOLTZ ENERGY IN KJ/KG
C 12: GIBBS ENERGY IN KJ/KG
C 13: FUGACITY IN MPA
C 14: ISOTHERMAL COMPRESSIBILITY IN MPA**(-1)
C 15: VOLUME EXPANSIVITY IN K**(-1)
C 16: DP/DRHO (CONSTANT T) IN MPA/(KG/M^3)
C 17: DP/DT (CONSTANT RHO) IN MPA/K
C 18: SPEED OF SOUND IN M/SEC
C 19: JOULE-TONSON COEFFICIENT IN K/MPA
C 20: THERMAL CONDUCTIVITY IN W/M-K
C 21: VISCOSITY IN PA-SEC
C 22: STATIC DIELECTRIC CONSTANT (RETURNED AS 999. IF
C CALCULATION COULD NOT BE DONE)
C 23: 2ND DERIVATIVE D2P/DRHO2 (CONSTANT T) IN
C MPA/(KG/M^3)**2
C 25: 2ND DERIVATIVE D2P/DRHO2 (CONSTANT T) IN
C MPA/(KG/M^3)**2
C 26: DRHO/DT (CONSTANT P) IN (KG/M^3)/K
C 27: DRHO/DP (CONSTANT T) IN (KG/M^3)/MPA
C 28: 2ND DERIVATIVE D2RHO/DT2 (CONSTANT P) IN
C (KG/M^3)/K**2
C 29: 2ND DERIVATIVE D2RHO/DP2 (CONSTANT T) IN
C (KG/M^3)/K**2
C 30: 2ND DERIVATIVE D2RHO/DTDP (CONSTANT P, T) IN
C (KG/M^3)/K/MPA
C 31: DIELECTRIC DERIVATIVE D(EPS)/DRHO (CONSTANT T)
C IN M^3/KG
C 32: DIELECTRIC DERIVATIVE D(EPS)/DT (CONSTANT RHO)
STEAM 56

**C**

**IN K**\(-1\)**

**C**

33: DIELECTRIC DERIVATIVE D(EPS)/DT \((\text{CONSTANT } F)\)**

**C**

34: ELECTRIC DERIVATIVE D(EPS)/DP \((\text{CONSTANT } T)\)**

**C**

IN MPA\(^{-1}\)**

**C**

35: 2ND DIELECTRIC DERIVATIVE D2(EPS)/DT2 \((\text{CONSTANT } P)\)**

**C**

36: 2ND DIELECTRIC DERIVATIVE D2(EPS)/DP2 \((\text{CONSTANT } T)\)**

**C**

IN MPA\(^{-2}\)**

**C**

37: 2ND DIELECTRIC DERIVATIVE D2(EPS)/DTDP \((\text{CONSTANT } P, T)\)**

**C**

38: DEBYE-HUCKEL SLOPE FOR ACTIVITY COEFFICIENT \((\text{KG/MOL})^{0.5}\)**

**C**

39: D-H SLOPE FOR OSMOTIC COEFF. IN \((\text{KG/MOL})^{0.5}\)**

**C**

40: D-H SLOPE FOR APPARENT MOLAR VOLUME \((\text{M}^3/\text{MOL})^{0.5}\)**

**C**

41: D-H SLOPE FOR APPARENT MOLAR ENTHALPY, DIVIDED BY RT, IN \((\text{KG/MOL})^{0.5}\)**

**C**

42: D-H SLOPE FOR APPARENT MOLAR COMPRESSIBILITY \((\text{M}^3/\text{MOL/MPA})^{0.5}\)**

**C**

43: D-H SLOPE FOR APPARENT MOLAR HEAT CAPACITY, DIVIDED BY R, IN \((\text{KG/MOL})^{0.5}\)**

**C**

PROPR RA = WORK VECTOR FOR REDUCED PROPERTIES PASSED TO PROPSL C

**C**

I2PHCK I I FLAG FOR WHETHER TO CHECK AND SEE IF REQUESTED T AND C

**C**

RHO IN 2-PHASE REGION. 0=DON'T CHECK, 1=CHECK C

**C**

I2PH I 0 OUTPUT FLAG FOR RELATION TO 2-PHASE REGION C

**C**

-1 = SUBCOOLED LIQUID (ALSO T<TC AND P>PC) C

**C**

1 = SUPERHEATED VAPOR (ALSO T>TC) C

**C**

2 = 2-PHASE REGION. QUALITY IS PUT IN SLOT 5, PROPS RETURNED IN PROPSI ARE APPROPRIATE AVERAGES FOR C

**C**

PROPS THAT CAN'T BE AVERAGED, ZERO IS RETURNED C

**C**

3 = UNABLE TO PERFORM 2-PHASE CHECK BECAUSE TK C

**C**

BELOW MINIMUM. PROPS RETURNED AS THOUGH 1-PHASE C

**C**

4 = SAME AS 2, EXCEPT 2-PHASE ENVELOPE EXTRAPOLATED C

**C**

TO REGION BELOW TRIPLE POINT C

**C**

***NOTE: FOLLOWING ARE FLAGS FOR WHETHER TO MAKE A CHECK(1=CHECK, C

**C**

0=DON'T) AND FLAGS RETURNED FROM THE CHECKS (0=OK OR NOT C

**C**

CHECKED, 1=EXTRAPOLATED BEYOND RECOMMENDED REGION, 2= C

**C**

UNACCEPTABLY OUTSIDE OF REGION C

**C**

ISCHK I I WHETHER TO CHECK IF EQUILIBRIUM PHASE IS SOLID C

**C**

ISFLG I 0 RESULT OF SOLID CHECK C

**C**

ICCHK I I WHETHER TO CHECK IF TOO NEAR CRITICAL POINT C

**C**

ICFLG I 0 RESULT OF NEAR-CRITICAL CHECK C

**C**

IPCHK IA I WHETHER TO CHECK BOUNDARIES FOR VARIOUS PROPERTIESC

**C**

ARRAY ELEMENTS ARE: 1: THERMODYNAMIC PROPERTIES C

**C**

2: VISCOSITY C

**C**

3: THERMAL CONDUCTIVITY C

**C**

4: DIELECTRIC CONSTANT C

**C**

5: REFRACTIVE INDEX C

**C**

IPFLG IA 0 RESULTS OF PROPERTY BOUNDARY CHECKS C

**C**

IGFLG I 1 WHETHER TO COMPUTE AND RETURN ONLY IDEAL-GAS PROPS C

**C**

1=IDEAL GAS, 0=REAL FLUID C

**C**

NRI I I NUMBER OF REFRACTIVE INDEX POINTS TO COMPUTE C

**C**

WAVRI RA I ARRAY OF WAVELENGTHS (IN MICROMETERS) AT WHICH TO C

**C**

COMPUTE REFRACTIVE INDEX C

**C**

RI RA 0 ARRAY OF RETURN FLAGS FOR REF. INDEX WAVELENGTHS C

**C**

0 = OK C

**C**

1(-1) = LARGER(SMALLER) THAN RECOMMENDED RANGE, C

**C**

VALUE IS AN EXTRAPOLATION C

**C**

2(-2) = TOO LARGE(SMALL), BEYOND REASONABLE C

**C**

EXTRAPOLATION RANGE. WILL STILL RETURN C

**C**

COMPUTED NUMBER IF WITHIN RANGE WHERE CALCS C

**C**

DOESN'T BLOW UP, OTHERWISE RETURNS ZERO. C

STEAM 56
PSAT, TSAT: Solve for vapor-liquid saturation (vapor-pressure) curve.

SUBROUTINE PSAT(TK, PMPA, RHOL, RHOV, IWORK, PROPR, IERR)
C---------------------------------------------------------------------
C                     *** PSAT ***                                   C
C THIS ROUTINE COMPUTES THE COEXISTENCE PRESSURE (IN MPA) AT A       C
C GIVEN TEMPERATURE (IN K).  IT ALSO RETURNS THE COEXISTING          C
C DENSITIES.  IT CALLS PCOEX, WHICH WORKS IN REDUCED UNITS.          C
C---------------------------------------------------------------------
C ARGUMENT LIST:                                                     C
C------- ---- ---- ----------------------------------------------- C
C TK      R    I   TEMPERATURE, K                                 C
C PMPA    R    O   COEXISTENCE PRESSURE, MPA                      C
C RHOL    R    O   SATURATED LIQUID DENSITY, KG/M3                 C
C RHOV    R    O   SATURATED VAPOR DENSITY, KG/M3                  C
C IWORK   IA   -   INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES C
C PROPR   RA   -   VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL C
C                  ROUTINES                                         C
C IERR    I    O   ERROR FLAG (FROM PCOEX)                         C
C 0 = SUCCESS                                                       C
C 1 = TEMPERATURE OUT OF RANGE                                      C
C 2 = UNABLE TO BRACKET (PROBABLY BECAUSE VERY CLOSE TO TC)         C
C TO TC) RETURN VALUES FROM SATURATION EQUATIONS                    C
C 3 = UNABLE TO CONVERGE BOUNDED SOLUTION.  RETURN LAST GUESS FOR    C
C SOLUTION                                                        C
C 4 = TEMPERATURE BELOW TRIPLE POINT BUT IN RANGE                   C

SUBROUTINE TSAT(PMPA, TK, RHOL, RHOV, IWORK, PROPR, IERR)
C---------------------------------------------------------------------
C                     *** TSAT ***                                   C
C THIS ROUTINE COMPUTES THE COEXISTENCE TEMPERATURE (IN K) AT A      C
C GIVEN PRESSURE (IN MPA).  IT ALSO RETURNS THE COEXISTING           C
C DENSITIES.  IT CALLS TCOEX, WHICH WORKS IN REDUCED UNITS           C
C---------------------------------------------------------------------
C ARGUMENT LIST:                                                     C
C------- ---- ---- ----------------------------------------------- C
C PMPA    R    I   PRESSURE, MPA                                   C
C TK      R    O   COEXISTENCE TEMPERATURE, K                       C
C RHOL    R    O   SATURATED LIQUID DENSITY, KG/M3                  C
C RHOV    R    O   SATURATED VAPOR DENSITY, KG/M3                   C
C IWORK   IA   -   INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES C
C PROPR   RA   -   VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL C
C                  ROUTINES                                         C
C IERR    I    O   ERROR FLAG (FROM TCOEX)                         C
C 0 = SUCCESS                                                       C
C 1 = PRESSURE OUT OF RANGE                                         C
C 2 = UNABLE TO BRACKET (PROBABLY BECAUSE VERY CLOSE TO TC)         C
C TO TC) RETURN VALUES FROM SATURATION EQUATIONS                    C
C 3 = UNABLE TO CONVERGE BOUNDED SOLUTION.  RETURN LAST GUESS FOR    C
C SOLUTION                                                        C
C 4 = TEMPERATURE BELOW TRIPLE POINT BUT IN RANGE                   C

STEAM 57
**PSUB, TSUB:** Solve for vapor-solid saturation (sublimation) curve.

**SURF:** Compute vapor-liquid surface tension at given temperature.
Example
Below, we reprint a brief program which demonstrates how routines in INTPK might be called. This program accepts a temperature input and computes the vapor pressure along with the density, enthalpy, entropy, and refractive index of the coexisting liquid and vapor phases.

PROGRAM EXAM
C
C - SAMPLE PROGRAM ILLUSTRATING FINDING VAPOR PRESSURE AT A TEMPERATURE
C - AND THEN FINDING SOME PROPERTIES OF COEXISTING VAPOR AND LIQUID
C
IMPLICIT DOUBLE PRECISION (A-H,O-Z)
INCLUDE 'nprop.cmn'
C - ALLOCATE ARRAYS FOR CALCULATIONS, PROPERTIES, AND ALSO BOUNDARY
C - CHECKS PERFORMED UNDER PROPS
DIMENSION IWORK(NPROP), IWANT(NPROP), PROPR(NPROP), PROPSI(NPROP)
DIMENSION WAVRI(NRIMAX), RI(NRIMAX), IRIFLG(NRIMAX)
DIMENSION IPCHK(5), IPFLG(5)
C
WRITE (*,111)
111 FORMAT (' ENTER TEMPERATURE IN KELVINS',/) READ (*,*) TK
C - CALL PSAT FOR SATURATION PRESSURE AND COEXISTING DENSITIES
CALL PSAT(TK, PVAP, RHOL, RHOV, IWORK, PROPR, IERR)
IF (IERR .NE. 1) THEN
C
C - CALL FOR PROPERTIES SEPARATELY FOR VAPOR AND LIQUID PHASES.
C - TO SAVE TIME, ONLY REQUEST CALCULATIONS FOR ENTHALPY AND ENTROPY.
C - SINCE THE VAPOR-LIQUID BOUNDARY IS IN RANGE FOR ALL THE
C - PROPERTY COMPUTATIONS, DO NOT CHECK BOUNDARIES. ALSO NO NEED
C - TO CHECK FOR 2-PHASE REGION
C - ALSO GET REFRACTIVE INDICES AT 0.5893 MICROMETERS (SODIUM D LINE)
C
DO 15 I=1,NPROP
IWANT(I) = 0
15   CONTINUE
IWANT(6) = 1
IWANT(7) = 1
DO 16 I=1,5
IPCHK(I) = 0
16   CONTINUE
NRI = 1
WAVRI(1) = 0.5893D0
CALL PROPS(IWANT, TK, RHOV, PROPSI, PROPR, 0, I2PH, 0, ISFLG,
HVP = PROPSI(6)
SVAP = PROPSI(7)
> 0, ICFLG, IPCHK, IPFLG, 0, NRI, WAVRI, RI, IRIFLG)
> 0, ICFLG, IPCHK, IPFLG, 0, NRI, WAVRI, RI, IRIFLG)
HLIQ = PROPSI(6)
SLIQ = PROPSI(7)
RILIQ = RI(1)
WRITE(*,222) TK, PVAP, RHOL, RHOV, HLIQ, HVAP, SLIQ, SVAP,
> RILIQ, RIVAP
222 FORMAT(' AT T(K) = ',F9.4,':',/,' PSAT(MPA) = ',G15.8,/,  
' LIQ. AND VAP. DENSITIES (KG/M3): ',2(9.2X,G15.8),/, 
' LIQ. AND VAP. ENTHALPIES (KJ/KG): ',2(9.2X,G15.8),/, 
' LIQ. AND VAP. ENTROPIES (KJ/KG.K): ',2(9.2X,G15.8),/ 
' LIQ. AND VAP. REFRACTIVE INDICES: ',2(9.2X,G15.8))
ENDIF
STOP
END
Appendix E

CONTACTS

If you have comments or questions about the database, the Standard Reference Data Program would like to hear from you. Also, if you should have any problems with the CD or installation, please let us know by contacting:

Joan Sauerwein
National Institute of Standards and Technology
Standard Reference Data Program
100 Bureau Drive, Stop 2310
Gaithersburg, MD  20899-2310
Internet:  data@nist.gov
Phone:  (301) 975-2008
FAX:   (301) 926-0416

If you have questions or problems pertaining to the data or use of the database program, contact:

Dr. Allan H. Harvey
Thermophysical Properties Division
National Institute of Standards and Technology
325 Broadway
Boulder, CO  80305
Internet:  aharvey@boulder.nist.gov